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Aims 

 



 

This tutorial is designed to introduce: 

 

· Plate IDs and the plate hierarchy, 

 

· Rotating features on the globe, and 

 

· Exporting reconstructed geometries 

 

We aim to provide a basic understanding of how plate rotation models work 

and how GPlates can be used to reconstruct features through time. You will 

then learn how to export reconstructed geometries so that they can be 

visualised, or further manipulated away from GPlates. 

 

 

Included Files 

 

 

Click here​ to download the data bundle for this tutorial. 

 

The tutorial dataset (2.1-Plate_Reconstructions.zip) includes the following 

files:  

 

Rotation file: Seton_etal_ESR2012_2012.1.rot 

 

Coastlines file: 

Seton_etal_ESR2012_Coastlines_2012.1_Polygon.gpmlz 

 

Plate ID Table: Seton_etal_ESR2012_PlateIDs (this document contains 

all the Plate ID’s we will be referring to, and that are contained in the 

EarthByte rotation model) 

 

Additional datasets and files, including rotations, coastlines, isochrons, 

spreading ridges and COB files can be downloaded at the following site: 

 

http://www.earthbyte.org/Resources/earthbyte_gplates.html 

 

This tutorial dataset is compatible with GPlates 1.5. 

Background to Plate Rotation Models 

 

ftp://ftp.earthbyte.org/earthbyte/GPlates/TutorialData_GPlates1.5/2.1-Plate_Reconstructions.zip
http://www.earthbyte.org/Resources/earthbyte_gplates.html
http://www.earthbyte.org/Resources/earthbyte_gplates.html
http://www.earthbyte.org/Resources/earthbyte_gplates.html


 

If you do not have a background in plate motions, we recommend that you 

read Cox and Hart (1986). Below are some definitions used in this tutorial 

(see GPlates manual for further details): 

 

Plate ID 

A Plate ID assigns a feature to a plate or tectonic element that has moved 

relatively to other plates for some period during its geological history. A 

Plate ID is a non-negative integer number. Tectonic elements can include 

anything from large plates to island arcs and relatively small blocks or 

terranes in regions experiencing complex deformation. In GPlates we also 

assign separate Plate ID’s to pieces of oceanic crust that were transferred 

from one plate to another by a ridge jump or propagation. Even though such 

pieces of crust were always part of one plate or another, we need to assign 

it a separate plate ID to model this process. The fixed reference frame of the 

Earth’s spin axis is assigned Plate ID 0, whereas sections of the Earth’s 

mantle that appear to have moved relatively coherently to other portions of 

the mantle can be assigned Plate IDs as well. For example the 

Atlantic-Indian hotspots are assigned Plate ID 001, whereas Pacific hotspots 

are assigned Plate ID 002. This remains so even for absolute plate motion 

models that consider relative motion between individual hotspots – however, 

each mantle plume can ultimately be assigned a Plate ID as well, and motion 

of a given plume relative to the spin axis can be modeled by a set of finite 

rotations (even though these rotations are not unique). This illustrates that 

we use plate ID’s not only for physical tectonic plates. A list of Plate IDs and 

corresponding descriptions can be found in the document 

Seton_etal_ESR2012_PlateIDs. 

 

Finite Rotations 

Euler's Displacement Theorem specifies that any displacement on the 

surface of the globe can be modelled as a rotation about some axis. This 

combination of axis and angle is called a finite rotation and can be expressed 

as a latitude, longitude and angle of rotation. Finite rotations are used by 

GPlates as the elementary building blocks of plate motion. 

 

Total Reconstruction Poles 

Total Reconstruction Poles tie finite rotations to plate motion. A total 

reconstruction pole is a finite rotation which "reconstructs" a plate from its 

present day position to its position at some point in time in the past. It is 

expressed as the combination of a "fixed" Plate ID, a "moving" Plate ID, a 



point in time and a finite rotation. 

 

Reconstructions are defined in a relative fashion; A single total 

reconstruction pole defines the motion of one plate id (the "moving" Plate 

ID) relative to another (the "fixed" Plate ID) at a specific moment in 

geological time. A sequence of total reconstruction poles is needed in order 

to fully model the motion of one particular plate across the surface of the 

globe throughout time. 

 

Anchored Plate ID 

A sequence of total reconstruction poles is used to model the motion of a 

single plate across the surface of the globe. Total reconstruction poles 

describe the relative motion between plates, but ultimately this motion has 

to be traced back to a single Plate ID which is considered "anchored". 

GPlates calls this the Anchored Plate ID. Generally, this Plate ID corresponds 

to an absolute reference frame, such as a hotspot, paleomagnetic, or mantle 

reference frame. The convention is to assign the anchored Plate ID to 000, 

but GPlates allows any Plate ID to be used as the anchored Plate ID. 

 

The Rotation Hierarchy 

To create the model of global plate rotations that is used in GPlates, total 

reconstruction poles are arranged to form a hierarchy, or tree-like structure. 

At the top of the hierarchy is the anchored Plate ID. Successive Plate IDs are 

further down the chain and linked by total reconstruction poles. To calculate 

the absolute rotation of a Plate ID of a feature with a given Plate ID (relative 

to the fixed reference defined by the anchored plate ID, at a given time), 

GPlates starts at that point in the hierarchy and works its way up to the top 

- to the root of the tree. 

 

For example, in the GPlates-compatible 2008 EarthByte Global Rotation 

Model, the South American plate (also known by the abbreviation “SAM”, 

with plate ID 201) moves relative to the African plate (“AFR”, 701), as does 

the Antarctic plate (“ANT”, 802), while the Australian plate (“AUS”, 801) 

moves relative to the Antarctic plate. This is illustrated in Figure 1. 

 



 

Figure 1.​ Sample of a simple rotation tree. 

 

 

Content of a rotation file 

Figure 2 is a section from a rotation file. The basic content is the same in 

other file formats e.g. GPML. 

 

Column 1: “Moving” Plate ID e.g. 652 

 

Column 2: Time e.g. 0.0 (Ma) 

 

Columns 3, 4, 5: Rotation poles. The first two are the coordinates of the pole 

of rotation (latitude, longitude), the third is the angle of rotation. 

 

Column 6: Conjugate or “fixed” Plate ID (Rotations relative to this plate) e.g. 

609 

 

Column 7: Abbreviation of Plate and Conjugate Plate and name, and 

sometimes the relevant reference e.g. WPV-NPS West Parece Vela Basin – 

North Philippine Sea. 

 

There are usually multiple entries for the same Plate ID, but with different 

times and rotation poles and, sometimes, different conjugate plates, to 

capture the rotation history of a given plate relative to neighboring, or 

conjugate plates. Which plate is assigned as a given plate’s conjugate 

depends on the user. Generally this choice is determined by where most of 

the constraints for reconstructing the relative motion history are, and this 

can be time-dependent. 

 

 



 

Figure 2.​ Sample of a rotation file. 

 

 

 

Exercise 1 – The Plate Hierarchy 

 

 

Here we will see what the plate hierarchy looks like in GPlates. 

 

1. Open GPlates 

 

2. File > Open Feature Collection (Figure 3) > navigate to the 2.1-Plate 

Reconstructions Tutorial directory (downloaded from the additional datasets 

link from global rotation and global coastlines respectively in the included 

files section) and select 

Seton_etal_ESR2012_Coastlines_2012.1_Polygon.gpmlz and 

Seton_etal_ESR2012_2012.1.rot > Open 

 

 



 

Figure 3.​ Opening a new feature collection from the Main Menu. 

 

 

 

3. Click and drag the globe to rotate it so that it is centered on the South 

Atlantic. You will see that all the plates are coloured according to their plate 

ID. Use the Choose Feature tool   to select and query some of the 

features. 

 

 

We will now view the plate hierarchy of the files loaded. 

 

 

4. Reconstruction > View Total Reconstruction Poles (Figure 4) > 

Reconstruction Tree (third tab, Figure 5). 

 



Figure 4.​ Navigating to View Total Reconstruction Poles from the Main Menu. 

 

 

 

 

Figure 5.​ The plate hierarchy is found under the Reconstruction Tree tab in the Total 

Reconstruction Poles window (third tab). 

 

 

You will see that the highest entry id is Plate ID 1 (001 – Atlantic-Indian 

hotspots) which is fixed to 0 (000 – Earth’s spin axis). 

 

 

5. Click the small triangle to the left of the ‘1’, this will reveal the next 



highest plate in the plate hierarchy - Plate 701 (Africa) (Figure 6). 

 

 

 

Figure 6.​ Expanding Plate ID 1, you reveal the next highest plate in the plate hierarchy. 

 

 

6. Now expand the tree even further by clicking the small triangle next to 

Plate ID 701. You will see that plates 201, 307 503, 507 etc move relative to 

701, which in turn moves relative to 001, which in turn is fixed to 000 

(Figure 7). 

 

 



 

Figure 7.​ The plate hierarchy tree for our loaded files. 

 

 

By expanding the tree, click Expand All, you can see how all the plates in the 

Coastline file move at the reconstructed time, i.e. which plates they move 

relative to. 

 

 

Changing something high in the rotation tree will affect the absolute 

rotations of all lower plates (relative motions will remain the same). For 

example, you may notice that the South American continent is divided into 

several plates with different Plate IDs. Rotating Plate ID 201 will 

subsequently move the lower Plate IDs 202, 203… etc, however, if you 

rotate Plate ID 202, Plate 201 will not be moved as it is higher than 202. You 

can always check the conjugate plate by looking at the information of a 

particular plate, or checking the reconstruction tree as above. 

 

 

Exercise 2 – Reconstructing data on the globe 

 

Now that you have some understanding of how a plate hierarchy works, and 

therefore the basics of a plate reconstruction model, it is a good idea to 



spend some time actually reconstructing the coastline data. We will now 

employ the rotation file to reconstruct our coastlines back to 100 Ma, 

 

 

The easiest way to reconstruct data is by using the Time (Figure 8) and 

Animation tools (Figure 9). 

 

 

 

Figure 8.​ The Time tools enable you to jump to a certain time. 

 

 

 

 

Figure 9.​ The Animation tools in the Main Window enable you to reconstruct data back and 

forth through time. 

 

 

A quick and way to jump straight to a certain time is by using the Time 

Controls. Simply enter the time you wish to reconstruct to and press enter. 

 

 

1. In the Time Controls box type 100 Ma > Enter. Rotate the globe and have 

a look at where the continents were 100 Ma (Figure 10). 

 

 



 

Figure 10.​ View of the coastlines at 100 Ma. Note that in the Time Controls box (top left) 

the time says 100.00 Ma. 

 

 

An alternative way to reconstruct your data is by using the Animation 

controls. You can simply click and manually move the time slider (notice that 

in Figure 10, the slider is no longer at the far right but is a third of the way 

along) or you may jump to a certain time and then “play” an animation of 

the feature data reconstructing. 

 

 

2. Make sure that you are still at 100 Ma (or jump to any time in the past) > 

press the play button in the Animation Controls  and watch the 

coastlines rotate back to their present-day positions. To animate the entire 

time period you have rotations for, first use the Reset button  to take 

you back to the oldest time you have rotations for and then press play. 

 

 

You may also watch animations of your data by using the Configure 



Animation option from the Reconstruction menu (Figure 11). 

 

Figure 11.​ Animations can be manually configures from the Reconstruction menu. 

 

 

 

The Animate window provides you additional control over your animation 

(Figure 12). For example, you can specify whether you want to watch a 

reconstruction run backwards or forwards through time by clicking the 

Reverse the Animation button. 

 



 

Figure 12.​ The Animate window allows you to specify details about your animations. 

 

 

 

GPlates also enables you to change the anchored plate (Figures 13) so that 

you can reconstruct data keeping different plates fixed. 

 

 

 



Figure 13.​ GPlates enables you to specify which Plate ID you keep fixed when 

reconstructing data. 

 

 

 

Spend some time altering the anchored plate ID to see the influence on the 

plate motions. For example, make an animation keeping South America 

fixed. 

 

 

3. Reconstruction > Specify Anchored Plate ID… > 201 > OK (Figures 13 and 

14) 

 

 

 

Figure 14.​ Nominating which plate to keep fixed. 

 

 

 

Once you have finished experimenting, set your anchored plate back to 000 

(the spin axis – default). 

 

 



Exercise 3 – Rotating features on the globe

 

In this exercise, we will cover the basics on how to rotate a feature on the 

globe. 

 

 

In the early 20th century, Alfred Wegener proposed that all continents might 

once have existed as a single supercontinent. He realised that the coastlines 

of eastern South America and western Africa fit together like a jig-saw 

puzzle. Let us use GPlates to replicate Wegener’s initial work. 

 

 

1. With the coastline and rotation files already loaded from the last exercise, 

click and drag the globe to rotate it so that it is centered on the South 

Atlantic. Make sure you are at 0 Ma. 

 

 

2. Our aim is to visually fit South America to Africa i.e. rotate South America 

relative to Africa. To select the feature to rotate (South America), click the 

select feature icon , and then click somewhere on the South American 

coastline. This will highlight the feature as a white outline (Figure 15). The 

feature attributes should appear in the panels to the right and bottom of the 

main reconstruction window. You will notice that the South American Craton 

has Plate ID 201. Click on the Africa coastline. What Plate ID corresponds to 

Africa? 

 

 



 

Figure 15.​ The South American coastline has been selected. 

 

3. Next, click on the Modify Reconstruction Pole tool . Note that any 

changes to a rotation pole for a particular Plate ID will affect all other 

features assigned to that particular rotation pole. In our case, all the 

coastlines that move relative to Plate ID 201 will be affected. 

 

4. After the feature has been selected by clicking anywhere on the coastline 

it can be moved anywhere on the globe by dragging (the feature will rotate 

about a point in the centre of the screen). The new location of the plate will 

be outlined in light grey (Figure 16). If at first you are not happy with the 

new location of South America, just click and drag again as appropriate. The 

feature can also be rotated about its axis by holding down SHIFT and 

dragging. 

 



Note: the globe can still be re-oriented whilst holding down the Command 

(Mac)/Control(PC) key while in the “Modify Reconstruction Pole” mode. 

Information regarding the reconstruction pole is displayed in the task panel 

to the right. This includes the Plate ID of the feature you are moving and the 

new rotation pole that will be applied if this location is confirmed by pressing 

Apply (applying rotations will be dealt with in the Rotations tutorial). 

 

 

 

 

Figure 16.​ Rotating and re-orienting South America. 

 

 

As mentioned above, changing a rotation pole for a particular Plate ID will 

affect all other features assigned to that particular rotation pole. GPlates 

enables you to see which plates will be influenced by your changes. Whilst 

using the Modify Reconstruction Pole tool you can choose to “Highlight 

children”, i.e. show plates that move relative to the plate you have selected. 

 

5. Tick Highlight children to the right of the globe (Figure 17 and 18) and 

notice the additional coastlines that move with South America and would be 

affected if you were to reconstruct South America differently. 



 

 

 

Figure 17.​ Highlighting children plates will enable you to see the implications of changing a 

particular rotation pole. 

 

 

 

 



Figure 18.​ Rotated South America, showing the Plate IDs (“children”) that would be 

influenced by the move. 

 
 
 
In the Rotation tutorial we will learn more about applying and modifying 

rotations. Do not apply this rotation now, simply click a different tool and the 

grey South America will disappear, or click ‘Reset Rotation’ on the 

Reconstruction Pole panel. 

 

 

Exercise 4 – Exporting reconstructed geometries 

 
GPlates allows you to export reconstructed geometries, either for a single 

snapshot or a sequence of snapshots. This functionality allows you to extract 

palaeo-coordinates for feature data that you have reconstructed back 

through time using a rotation model. Reconstructed geometries can be 

exported as a file containing longitudes and latitudes (i.e. in the GMT format, 

*.xy) or in the shapefile format to be used in GIS software. 



 

 

To illustrate this procedure we will export reconstructed geometries for our 

coastlines. 

 

 

1. Reconstruction > Export… (Figure 19) 

 

 

Figure 19.​ Navigating to the Export window. 

 

 

 

The Export Animation window is where you specify what type of data you are 

exporting and for which period of time. We will export our coastline 

geometries for the time period 50 Ma – 0 Ma, with an increment of 5 Myr. 

 

 



 

Figure 20.​ The Export Animation window​. 
 
 
 
2. Next we must select which files we want GPlates to create. Add Export> 

select the Reconstructed Geometries option from the top box > choose the 



GMT (*.xy) format > Add > Close (Figure 21) 

 

 

Figure 21.​ The Add Export window allows you to select which data you want to export, and 

in which format. 

 

 
 
3. Now ensure that you have selected a target directory where your files will 

be created (Figure 22). When you are satisfied with all the criteria click 

Begin Animation (bottom). 

 

 



 

Figure 22.​ Once all the Export Animation fields have been filled hit Begin Export. 

 
 
 



4. Go to the target directory where your files have been sent. You will notice 

that GPlates has named the files according to the time the data is for and 

the number the file is in the sequence of files. The first file is named 

reconstructed_0.00Ma.xy, the second file is reconstructed_1.00Ma.xy etc. 

Open one of the files and have a look at the output. 

 

These data can now be plotted using GMT, for example. This GPlates 

function allows for quick and easy extraction of palaeo-coordinates for use 

outside of GPlates. 

 

Note: GPlates will extract the reconstructed geometries of all feature data 

actively being displayed on the Globe. Therefore, turn off the data you do 

not wish to export the reconstructed geometries for. For example, if you also 

had the EarthByte Continent-Ocean Boundaries displayed on the globe but 

you did not wish to extract their reconstructed geometries, then you would 

go to File > Manage Feature Collections > and either Eject the unwanted 

files or in the "Layers" window (separate from the main GPlates window) 

uncheck the eye button, then follow the procedure above. 
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